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Lernziele  Was kann ich von diesem Handbuch erwarten?  

In diesem Handbuch wirst du mit der kostenfreien Software QGIS vertraut gemacht.  

Nach dem Bearbeiten dieses Handbuchs kannst du:  
 

1. Beschreiben, was ein GIS ist und wofür es angewendet wird.  

2. Die für dich geeignete QGIS-Version eigenständig herunterladen und installieren.  

3. Eine Referenzkarte und Satellitendaten in QGIS einladen.  

4. Zwischen verschiedenen Datentypen und deren Eigenschaften innerhalb des GIS 
unterscheiden.  

5. Ein adäquates Koordinatensystem auswählen.  

6. Die Darstellung von Satellitendaten anpassen.  

7. Mit Hilfe verschiedener Bildkanäle umweltanalytische Indizes berechnen.  

8. Vektordaten aus vorhandenen Daten in QGIS einladen, aus einem Web Feature 
Service gewinnen und durch Abdigitalisieren generieren.  

9. Bildausschnitte extrahieren und abspeichern. 
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Was ist QGIS und wie installiere ich es? 

QGIS 1 ist ein freies Geoinformationssystem, mit dem du Geodaten, also Daten mit 
Raumbezug, erfassen, darstellen, analysieren und weiterverarbeiten kannst, zum 
Beispiel Satellitendaten. Die Open-Source-Software ist kostenlos und darf unter der 
General Public License für alle Zwecke genutzt werden, auch kommerziell.  

Du findest QGIS unter https://www.qgis.org/de.  

Klicke auf QGIS ENTDECKEN, um mehr über das Programm zu erfahren.  

Zum Herunterladen des Programms klicke auf Jetzt herunterladen.    

 

 

Auf der folgenden Seite findest du unter dem Tab Installationsdownloads verschiedene 

Downloadpakete zu den jeweiligen Betriebssystemen. Wähle eines der eigenständigen 
Installationspakete für dein Betriebssystem aus den verfügbaren Optionen. Du kannst 
dabei jeweils zwischen der aktuellen Version und der langfristig stabilen Version wählen. 
Wir empfehlen die langfristig stabile Version (Long Term Release) bzw. „Version mit 
Langzeitunterstützung“, da hier keine Programmierfehler mehr auftreten sollten und ein 
vollständiges Handbuch bereit gestellt wird. In unseren Schulungen und Handbüchern 
benutzen wir durchgehend die Version QGIS 3.16 Hannover. Wenn du eine andere QGIS-
Version benutzt, kann es bei einigen Schritten zu leichten Abweichungen kommen.  

Du brauchst Administratorrechte, um QGIS zu installieren. 

Abb. 1 

https://www.qgis.org/de
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Achte bei einer Windows-Installation auf den richtigen Systemtyp (32bit oder 64bit). Den 

Systemtyp deines Computers findest du mit dem Windows Explorer unter Dieser PC > 

Eigenschaften im Abschnitt System. 

 

Speichere die Datei und öffne sie nach dem Download. Folge dann den Anweisungen, die 
dich durch die Installation führen. Öffne dann z.B. über das Windows Startmenü das 
Programm QGIS Desktop. Hast du eine ältere QGIS-Version, wähle QGIS mit GRASS. 

  

 

  

Abb. 2 

Abb. 3 
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Wie ist die Bedienoberfläche von QGIS aufgebaut? 

Nachdem du das Programm geöffnet hast, siehst du die Benutzeroberfläche von QGIS, 
die in Menüleiste, Werkzeugkästen, Bedienfelder und ein Kartenfenster gegliedert ist. 
Ganz oben erscheint die Menüleiste und darunter diverse Werkzeugkästen mit 

verschiedenen Symbolen. Welche Bedienfelder und Werkzeugkästen dir in QGIS 
angezeigt werden, kannst du selbst bestimmen. Per Rechtsklick auf den Menübereich 
oder im Menü unter Ansicht > Bedienfelder bzw. Werkzeugkästen kannst du die Auswahl 

an deine Bedürfnisse anpassen.  

 

 

In der Menüleiste findest du alle wichtigen Optionen und Werkzeuge. Über die einzelnen 
Menüpunkte kannst du z.B. die Projekteigenschaften einstellen, zusätzliche 

Erweiterungen (engl. plugins) installieren (vgl. S.10: Wie lade ich eine Referenzkarte?) 

oder die Verarbeitungswerkzeuge als Fenster öffnen, das alle Werkzeuge übersichtlicht 

darstellt und eine einfache Suche ermöglicht.  

 

Auf der linken Seite der QGIS-Oberfläche siehst du im Browser-Bedienfeld (1) alle 

Ressourcen, die dir in QGIS zur Verfügung stehen, deine Dateiordner und Laufwerke, 
Web-Services, Lesezeichen und Favoriten. Von hier aus kannst du per Drag & Drop direkt 
Daten in die Kartenansicht (2) ziehen; in diesem Bereich werden die Daten dann 

Viele Unterpunkte des Menüs lassen sich auch per Tastaturkürzel oder über das 
entsprechende Werkzeugsymbol aufrufen. 

 

v v 

v 

Abb. 4 

Abb. 5 
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visualisiert. Hier kannst du einzelne Elemente ansehen und die Sicht auf die Daten durch 

Ein- und Auszoomen anpassen.  

Links unten im Ebenen- bzw. Layer-Bedienfeld (3), erscheinen alle eingeladenen Daten 

als übereinander liegende Ebenen (engl. layer). Durch Rechtsklick auf einen Layer kannst 
du die Eigenschaften (auch visuelle Darstellung) und Attributtabellen einsehen und 
bearbeiten oder einen Layer kopieren, bearbeiten oder löschen. Je nach Datentyp (Raster- 
oder Vektordaten) werden andere Eigenschaften angezeigt.  

Ganz unten befindet sich noch eine Statusleiste (4), welche die wichtigsten Eckdaten zu 

deiner aktuellen Kartenansicht kompakt zusammenfasst, wie beispielsweise das 
verwendete Koordinatenbezugssystem, Koordinaten, Maßstab und die aktuell im Projekt 
verwendete Vergrößerung der Ansicht. 

 

 

  

 

 

 

2 

3 

1 

4 

Abb. 6 
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Wie lege ich ein QGIS-Projekt an? 

Links über der Menüleiste steht jeweils der Name des aktuellen Projektes, denn die Arbeit 
in QGIS wird in einer Projektdatei organisiert. Solange du nichts abgespeichert hast, 
bleibt dein aktuelles Projekt als Unbenanntes Projekt  QGIS unbenannt. Lege also eine 

neue Projektdatei an und sichere anschließend dein Projekt. Klicke dazu a) im 
Kartenfenster auf Neues leeres Projekt oder b) die Tastenkombination STRG+N oder c) im 

Menü auf Projekt > Neu oder d) auf das Seiten-Symbol. Zum Speichern kannst du z.B. das 

Disketten-Symbol verwenden, aber auch hier gibt es wieder verschiedene Wege. Gib 

anschließend, einen Dateipfad und -namen an.  

 

 

Wenn du dein QGIS-Projekt das nächste Mal öffnest, wird alles wieder genau so aussehen 
und angeordnet sein, wie zum Zeitpunkt des letzten Speicherns; alle Layer (sofern sie 

nicht aus ihren Ordnern verschoben oder gelöscht wurden) und Layereigenschaften, das 
Projekt-KBS, die letzte Kartensansicht, etc. werden gespeichert.   

 

Vermeide generell Leerzeichen in Dateinamen und Dateipfaden. Diese können in 
QGIS bei verschiedenen Verarbeitungswerkzeugen zu unerwarteten Fehlern führen.  

Abb. 7 
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Wie lade ich eine Referenzkarte?  

Basiskarten wie topographische Karten, Straßenkarten oder weltweit flächendeckende 
Satellitenbildkarten dienen der Orientierung bei der Arbeit mit Geodaten in einem GIS, 
denn sie setzten deine Daten in einen geografischen Kontext. Oft werden sie auch als 
Kartengrundlage genutzt, um andere Daten ansprechend zu visualisieren.  

Einen sehr einfachen Weg diese Basiskarten als Hintergrund in QGIS einzuladen, 
ermöglicht die Erweiterung QuickMapServices. Um sie in QGIS zu integrieren, öffne im 
Menü Erweiterungen > Erweiterungen verwalten und installieren, nutze die 

Suchfunktion und wähle QuickMapServices aus der Ergebnisliste aus. Klicke dann auf 

Erweiterung installieren.  

 

Du findest QuickMapServices daraufhin unter dem Menüpunkt Web bzw. als QMS-Symbol in 

der Werkzeugleiste. Wähle OSM und OSM Standard für die gewohnte OpenStreetMap-Karte. 

 

Wenn du weitere Basiskarten haben möchtest, kannst du unter Web > QuickMapServices > 

Settings > More services > Get contributed Pack > Speichern zusätzliche Karten 

hinzufügen. Du findest dann unter QuickMapServices eine Vielzahl verschiedener 
Basiskarten.  

 

Abb. 8 

Abb. 9 
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Wie lade ich Satellitendaten in QGIS ein?   

Importieren einer Sentinel-2-Szene 

Sentinel-2-Daten und andere Satellitendaten kannst du kostenfrei über viele 
verschiedene Datenportale beziehen, z.B. über das deutschsprachige Portal CODE-DE 2. 
In unsem SAPIENS-Handbuch Passende Satellitendaten finden – Das Datenportal CODE-
DE 3 stellen wir CODE-DE vor und zeigen dir, wie du damit Satellitendaten anschauen und 
herunterladen kannst.  

Die Sentinel-2-Satelliten nehmen mit dem Multispektral-Instrument (MSI) Daten in 
verschiedenen Wellenlängenbereichen auf und speichern sie in 13 verschiedenen 
Kanälen bzw. Bändern.  

 

Lade die benötigten Bänder in dein QGIS-Projekt. Navigiere dazu zum Speicherort deiner 
Sentinel-2-Daten und entpacke ggf. die im Zip-Format vorliegenden Satellitendaten. Die 

Bilddaten sind bei Level 2A-Produkten immer im Ordner GRANULE bzw. IMG_DATA abgelegt. 

Wähle den Ordner mit der höchsten Auflösung (R10m).  

Für eine Visualisierung in Echtfarben benötigst du die Sentinel-2 Bänder rot, grün und 
blau, also 4, 3 und 2. Zusätzlich brauchst du Band 8 für die Darstellung als 
Falschfarbenbild und zur Berechnung von Vegetationsindizes. Markiere mit gedrückter 
STRG-Taste die Bänder B02, B03, B04 und B08 und ziehe sie dann per Drag & Drop mit 

gehaltener linker Maustaste in das QGIS-Programmfenster. Lass dann die Maustaste los. 

 

Abb. 10 

Abb. 11 
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Satellitendaten sind Rasterdaten, eine der zwei Geodatentypen, mit denen im GIS 

gearbeitet wird. Du kannst die Bänder alternativ also auch über den Menüpunkt Layer > 

Layer hinzufügen > Rasterlayer hinzufügen > ... einladen.  

 

Navigiere zum Speicherort der Bilddaten, wähle die benötigten Bänder aus mit Hilfe der 
SHIFT- oder STRG-Taste, bestätige deine Auswahl über die Öffnen-Schaltfläche und 

anschließend die Hinzufügen-Schaltfläche.  

Die Bänder erscheinen jetzt als übereinandergelagerte Layer im Kartenfenster rechts. Im 
Layer-Fenster links sind alle in der Karte enthaltenen Layer aufgelistet, wobei ein weiter 
oben liegender Layer alle darunter liegenden überdeckt.  

Verändere die Layerreihenfolge, indem du einzelne Layer bei gedrückter Maustaste an 
eine andere Position ziehst und loslässt. Eine dünne Linie markiert die Stelle, an der ein 
Layer beim Loslassen abgelegt wird. Mit den Häkchen bestimmst du die Sichtbarkeit der 

Layer.  

Klicke mit der rechten Maustaste auf einen der Sentinel-Layer und wähle Auf den Layer 

zoomen aus, um den Bildausschnitt anzupassen oder zoome und verschiebe die Karte mit 

der Maus, bis du die gesuchte Stelle erreichst. 

 

Abb. 12 

Abb. 13 
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Anpassen des Koordinatenbezugssystems 

Mit dem Koordinatenbezugssystem (KBS) wird festgelgt, mit welcher Art von 
Koordinatensystem, Erdkörper-Modell und Kartenprojektion die dreidimensionale Welt in 
einer zweidimensionalen Karte dargestellt werden soll. Oft stammen Daten, die für ein 
GIS-Projekt benötigt werden, aus verschiedenen Quellen und besitzen unterschiedliche 
KBS. Auch dem QGIS-Projekt selbst kann ein KBS zugewiesen werden. Für ein optimales 
Ergebnis ohne größere Verzerrung solltest du ein geeignetes KBS auswählen und das KBS 
deines Projektes an die darzustellende Region bzw. deine eingeladenen Daten anpassen. 
Je nach Art der geplanten Analyse, der räumlichen Ausdehnung des Arbeitsgebietes und 
oft auch abhängig von der Verfügbarkeit der Daten eignen sich bestimmte 
Kartenprojektionen und Koordinatenbezugssysteme mehr oder weniger für ein 
bestimmtes Projekt.   

 

Ein Referenzsystem, das für Darstellungen über Deutschland häufig verwendet wird, ist 
z.B. das amtliche Koordinatenbezugssystem EPSG:25832 bzw. EPSG:25833. Weitere 
typische Georeferenzierungen findest du hier:  

https://gdz.bkg.bund.de/index.php/default/georeferenzierungen  

Meist nimmt das Projekt automatisch das KBS der Daten an, die man zuerst einlädt. Fügt 
man dann weitere Daten hinzu, die ein anderes KBS besitzen, werden sie augenblicklich 
in das bestehende Projekt-KBS reprojiziert. Das ist praktisch, kann aber u.U. die 
Perfomance des Programmes schwächen und zu fehlerhaften Prozessierungen führen. 
Achte also am besten darauf, dass alle Layer im Projekt ein einheitliches 
Koordinatensystem besitzen und neu eingeladene Layer immer in das gewünschte KBS 
überführt werden.  

Bei der Arbeit mit Satellitendaten hat sich dabei die Praxis bewährt, das KBS der 

Satellitendaten zu verwenden und alle anderen Daten in dieses KBS zu reprojizieren, 
denn das Umprojizieren von großen Rasterdaten ist weitaus zeitaufwändiger und 
fehlerbehafteter als das Reprojizieren von Vektordaten (vgl. S.32: Reprojizieren von 
Vektordaten).  

Du kannst das Projekt-KBS aber auch jederzeit neu definieren. Die entsprechende 
Dialogbox öffnest du im Menü unter Projekt > Eigenschaften > KBS oder mit einem Klick 

auf die EPSG-Schaltfläche rechts unten in der Statusleiste von QGIS.  

 

Da es sehr viele verschiedene KBS gibt, nutzt man zur Unterscheidung die EPSG-
Codes. Die vier- bis fünfstelligen Codes, die ursprünglich von der European 
Petroleum Survey Group Geodesy, also Europäischen Öl- und 
Gasförderunternehmen entwickelt wurden, dienen der eindeutigen Bezeichnung 
von Koordinatenreferenzsystemen und Kartenprojektionen weltweit. 

Abb. 14 

https://gdz.bkg.bund.de/index.php/default/georeferenzierungen
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In unserem Fall hat das Projekt automatisch das KBS der OSM-Basiskarte angenommen, 

wir möchten es aber auf das Bezugssystem der Satellitendaten einstellen. Die  
Sentinel-2-Daten sind im WGS84-UTM-System referenziert. Unsere Sentinel-2-Szene liegt 
in der UTM-Zone 33N, das KBS ist EPSG:32633. Gib den EPSG-Code 32633 in die Suchleiste 

bei Filter ein, wähle das KBS aus der Liste unter Vordefinierte Koordinaten-

bezugssysteme aus und klicke auf OK. 

 

 

Du siehst nun die Sentinel-Kacheln in ihrer quadratischen Ausdehnung von 100 x 100 km. 

  

Welches KBS ein Layer besitzt, kannst du mit einem Rechtsklick auf den Layer > 
Layereigenschaften > Information herausfinden oder indem du einfach deinen 
Mauszeiger kurz über dem Layer im Layer-Bedienfeld ruhen lässt. 

Abb. 15 

Abb. 16 
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Wie kann ich die Satellitendaten farbig darstellen? 

Umwandeln der Satellitendaten in ein Mehrkanalraster 

Um aus den einzelnen Bändern ein farbiges Multikanalbild und verschiedene 
Bandkombinationen zu erstellen, müssen die Bänder in einem einzigen Raster 
zusammengefasst werden. Nutze dazu die Funktion Virtuelles Raster generieren im 

Menü unter Raster > Sonstiges. Alternativ kannst du mit Raster > Sonstiges > Verschmelzen 

auch ein reales Raster aus Einzelbändern erzeugen. Je nach Anzahl der Datensätze und 
deren Auflösung nimmt das Verschmelzen aber wesentlich mehr Zeit und Speicherplatz 
in Anspruch. Ein virtuelles Raster wird dagegen sehr schnell generiert. Bei Bedarf kann 
man jederzeit aus einem virtuellen Raster über Rechtsklick > Exportieren > Speichern 

 eine physische Rasterdatei erzeugen. 

Ein virtuelles Raster lässt sich wie ein normaler Rasterlayer bearbeiten, wobei die 
Originaldateiein der einzelnen Bänder nicht gelöscht oder verschoben werden dürfen. 
Denn die einzelnen Originaldateien werden im Hintergrund beibehalten; es entsteht  
lediglich eine Katalog-Datei in Textformat. Solange die Dateiverknüpfungen zu den 
Quelldaten des Layers erhalten bleiben, diese also nicht verschoben oder gelöscht 
wurden, kannst du den virtuellen Layer immer wieder nutzen. 

 

Wähle unter Input Layers ... die Bänder 2 (blau), 3 (grün), 4 (rot) und 8 (Nahes Infrarot) 

mit den entsprechenden Häkchen aus und klicke OK. Setze die gewünschte Auflösung 

unter Resolution auf Highest. Achte darauf, dass das Häkchen bei place each input file 

into a separate band gesetzt ist, damit die Farbkanalkombination des Rasterbildes 

später verändert werden kann.  

 

Beim Generieren des virtuellen Rasters wird QGIS die Bänder 2, 3, 4 und 8 in Kanal 
1, 2, 3 und 4 umbenennen, wobei das Band an erster Stelle zu Kanal 1 wird, das 
Band an zweiter Stelle zu Kanal 2, usw. Beachte daher die Reihenfolge bei der 
Anordnung der Bänder, um später die Zuordnung nachvollziehen zu können.  

Verändere gegebenenfalls die Reihenfolge der Bänder mit Hilfe der Maus durch 
Anklicken, Verschieben und Loslassen. Durch das Öffnen der VRT-Datei in einem 
Texteditor kannst du die Dateipfade sehen, die zu den Originalbändern verweisen 
und daran auch ablesen, welches Band welchem Kanal zugeordnet wurde. 

Das virtuelle Raster wird nur temporär angelegt, wenn du unter Virtuell > [In 
temporärer Datei speichern] nichts angibst, d.h. dein Layer geht verloren, sobald 
du dein QGIS-Projekt schließt. Möchtest du später wieder darauf zurückgreifen, 
solltest du über ... > in Datei speichern eine Ausgabedatei anlegen.  
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Du solltest auch das Häkchen bei Öffne Ausgabedatei nach erfolgreicher Ausführung 

setzen, so dass du dein Ergebnis sofort in der Karte sehen kannst. Klicke dann auf Starte 

und schließe den Dialog, nachdem das Raster generiert wurde.  

 

Der virtuelle Layer erscheint im Layer-Bedienfeld unter dem Namen Virtuell.  

 

Gib dem virtuellen Raster bei Bedarf einen anderen Namen, indem du mit der rechten  

Abb. 17 

Abb. 18 
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Maustaste darauf klickst und Layer umbenennen wählst. Layernamen kannst du außerdem 

auch per Doppelklick auf den Layer über die Layereigenschaften unter Quelle ändern.  

 

Symbolisieren eines Mehrkanalrasters in Echt- oder Falschfarben 

In den Layereigenschaften müssen die verschiedenen Bänder innerhalb des virtuellen 

Layers den RGB-Farbkanälen zugeordnet werden, um Bandkombinationen zu erstellen. 
Doppelklicke dazu auf den virtuellen Layer im Layer-Bedienfeld oder gehe über die rechte 
Maustaste auf Eigenschaften > Symbolisierung. Für ein Echtfarbenbild (True Color Image, 

TCI) wählst du unter Roter Kanal Band 4 aus, das im roten Spektralbereich liegt (hier 

durch die Art des Bandimports als Kanal 3 bezeichnet), unter Grüner Kanal Band 3 aus 

dem grünen Spektralbereich (hier Kanal 2) und unter Blauer Kanal das Band 2 aus dem 

blauen Spektralbereich (hier Kanal 1).  

 

Abb. 19 

Abb. 20 

Abb. 21 
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Für ein Falschfarben-Infrarotbild (Colored Infrared, CIR) legst du Band 8 aus dem Nahen 

Infrarotbereich (hier Kanal 4) in den Roten Farbkanal, Band 4 aus dem grünen 

Spektralbereich (hier Kanal 3) in den Grünen Farbkanal und grüne Band 3 (hier Kanal 2) 

für den blauen Kanal aus. Auch andere Bandkombinationen sind möglich.  

  

 

  

Abb. 22 

Abb. 23 
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Was ist ein Index und wie wird er berechnet? 

Anhand unterschiedlicher Reflexionseigenschaften von Objekten können mit 
Satellitendaten Aussagen z.B. über die Biomasse, Vitalität und Art von Vegetation 
getroffen werden. Über simple Bandkombinationen hinaus kann man zu diesem Zweck 
auch sog. Indizes nutzen, die gezielt bestimmte Merkmale der Erdoberfläche 
hervorheben und auch quantitative Aussagen ermöglichen. Ein Index stellt 
gewissermaßen einen künstlichen Kanal dar, der als lineare Kombination oder Bruch 
(Ratio) verschiedener Bänder berechnet wird.  

Es existieren eine Vielzahl von Indizes. Der wohl bekannteste ist der „Normierte / 
Normalisierte Differenzierte Vegetationsindex“ (Normalized Difference Vegetation Index, 
kurz NDVI) 4. Der NDVI gibt Aufschluss über die Vitalität der Vegetation 
(Chlorophyllgehalt), denn Vegetation unter (Trocken-)Stress reflektiert einerseits stärker 
im roten Bereich, andererseits weniger stark im Nahen Infrarot (NIR). Die Werte des NDVI 
reichen von -1 bis +1. Zur Berechnung des NDVI werden die Werte des NIR-Kanals (Band 
8) und des Rot-Kanals (Band 4) herangezogen. Er wird wie folgt berechnet: 

𝑁𝐷𝑉𝐼 =  
𝑛𝑖𝑟 − 𝑟𝑜𝑡

𝑛𝑖𝑟 + 𝑟𝑜𝑡
 

 

Benutzen des Rasterkalkulators 

Mit dem Rasterkalkulator lassen sich in QGIS eingeladene Rasterdaten neu berechnen 
oder auch miteinander verrechnen. Das ist nützlich, wenn man aus Satellitendaten 
Vegetationsindizes wie den NDVI berechnen möchte, denn dafür werden Informationen 
aus verschiedenen Bändern benötigt. Du findest den Rasterkalkulator in den QGIS-
Verarbeitungswerkzeugen unter Rasteranalyse > Raster calculator oder durch die 

Benutzung der Suchleiste. Falls der Werkzeugkasten nicht angezeigt wird, aktiviere ihn 

im Menü unter Ansicht > Bedienfelder > Verarbeitungswerkzeuge oder über das Zahnrad-

Symbol. 

 

Abb. 24 
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Berechnen eines Index per vordefinierter Formel am Beispiel NDVI 

Im Rasterkalkulator von QGIS ist die Formel für den NDVI bereits unter Vordefinierte 

Ausdrücke gespeichert, so dass du unter Hinzufügen nur noch die beiden benötigten 

Bänder auswählen musst. Wähle Band _B08_ für NIR und Band _B04_ für Red. Klicke auf OK. 

Daraufhin siehst du im Feld Ausdruck die vordefinierte NDVI-Formel mit den automatisch 

hinzugefügten Bändern. Lege anschließend unter Reference layer(s) > ... einen 

Bezugslayer fest, über den du Pixelgröße, Ausdehnung und KBS der Ausgabedatei 
bestimmst. Im einfachsten Fall wäre das einer der Eingabelayer, also Band 4 oder 8.  
Du hast aber auch die Möglichkeit, diese Parameter unter Cell size (Pixelgröße), Output 

extent (Ziel-Ausdehnung) und Output CRS (Ziel-KBS) ohne einen Referenzlayer separat 

festzulegen.  

Unter Output legst du Name, Dateiformat und Speicherort deines späteren Ergebnisses 

fest. Lässt du das Feld leer, wird ein temporärer Layer angelegt, der beim nächsten 
Programmstart nicht mehr verfügbar ist. Gibst du hier lediglich einen Namen ein, wird der 
Layer tief verborgen in der QGIS-Programmstruktur abgelegt und lässt sich schwer 
wiederfinden. Klickst du auf ... > In Datei speichern... kannst du das Ausgaberaster in 

beliebigem Format dauerhaft abspeichern.  

Setze abschließend ein Häkchen bei Öffne Ausgabedatei nach erfolgreicher 

Ausführung und klicke auf Starte.  

 

 

Abb. 25 
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Schließe den Rasterkalkulator nach der Berechnung. Das Ergebnis ist ein neuer NDVI-

Layer (hier als Output bezeichnet, da kein Name angegeben wurde), der im Layer-

Bedienfeld erscheint und in Graustufen dargestellt wird. Benenne den Layer am besten 
so um, z.B. NDVI. Das erleichtert die Organisation, besonders bei vielen Layern im Projekt.  

 

 

Symbolisieren eines Einkanalrasters am Beispiel NDVI 

Der NDVI-Layer soll nun farbig dargestellt werden, damit die unterschiedlichen NDVI-
Werte klarer zu erkennen sind. Öffne dazu mit einem Doppelklick auf den Layer NDVI 

dessen Layereigenschaften und dort den Reiter Symbolisierung. Der Rasterlayer NDVI 

besitzt im Gegensatz zum Echt- oder Falschfarbenbild nur einen Farbkanal; er ist ein 
Einkanalraster. Stelle unter Darstellungsart Einkanalpseudofarbe ein und wähle einen 

passenden Farbverlauf, z.B. von Rot über Gelb zu Grün (RdYlGn).  

Um die farblichen Unterschiede für einen bestimmten Ausschnitt deutlicher 

hervorzuheben, kannst du unter Min/Max-Werteinstellungen die Statistikausdehnung 

auf Aktueller Ausschnitt begrenzen. Dadurch werden nur Werte berücksichtigt, die sich 

im aktuellen Ausschnitt befinden. Empfehlenswert ist außerdem die Umstellung des 
Modus auf Quantile. Damit erreichst du, dass die Klassifizierung, also die Einteilung der 

Werte in verschiedene Gruppen, gleichmäßiger wird, weil so jeder Klasse gleich viele 
Werte zugeordnet werden.  

 

Die Verteilung der Pixelwerte eines Rasterlayers kannst du im Histogramm unter 
Layereigenschaften > Histogramm einsehen.   

 

Abb. 26 
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Du kannst auch eigene Wertegrenzen definieren. Doppelklicke dazu einfach in die Wert-

Spalte der Klassifizierungstabelle und trage die gewünschten Werte ein. Dasselbe gilt für 
die Spalte Beschriftung. Auch die Anzahl der Klassen kann individuell festgelegt werden.  

 

Unter Farbdarstellung findest du weitere Optionen zu Bildeigenschaften wie 

Mischmodus, Helligkeit, Kontrast etc., mit denen du die Darstellung des Layers 
optimieren kannst. Setze die Genauigkeit auf Genau (langsamer), wenn du mit der 

Darstellung zufrieden bist und schließe den Dialog mit OK.  

 

 

QGIS verwendet nur die englische Dezimalschreibweise, also Punkt statt Komma! 

Nutze Anwenden statt OK, um den Dialog nicht jedes Mal schließen zu müssen.    

Abb. 27 
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Im Kartenfenster werden nun negative Werte in rot (im Fall des NDVI meist 
Wasserflächen), positive niedrige Werte in orange (geringe Vitalität) bis hohe Werte nahe 
1 (vitale Vegetation) in dunkelgrün dargestellt.  

 

 

Berechnen eines Index per manueller Eingabe am Beispiel NDWI 

In QGIS können auch eigene Indexberechnungen und Bandberechnungen im Allgemeinen 
mit dem Rasterkalkulator durchgeführt werden. Als Beispiel wollen wir hier den 
„Normalisierten Differenzierten Wasser-Index“ NDWI nach Gao 5 berechnen. Der Index 
eignet sich, um Unterschiede im Wassergehalt der Blätter darzustellen. Er wird häufig zur 
Überwachung von Wasserstress in der Vegetation verwendet. Zur Berechnung werden die 
Bänder Nahes Infrarot (Band 8) und Kurzwelliges Infrarot (Band 11) benutzt:  

𝑁𝐷𝑊𝐼 =  
𝑛𝑖𝑟 − 𝑠𝑤𝑖𝑟

𝑛𝑖𝑟 + 𝑠𝑤𝑖𝑟
 

Lade Band 11 (nur in 20m Auflösung verfügbar) als zusätzlichen Layer in dein GIS-Projekt 
(vgl. S.11, Importieren einer Sentinel-2-Szene). Öffne den Rasterkalkulator in den 
Verarbeitungswerkzeugen unter QGIS-Tools > Rasteranalyse > Raster calculator. Die 

Formel für NDWI ist nicht vordefiniert. Kopiere daher den Ausdruck  

(_B08_ - _B11_) / (_B08_ + _B11_ ) 

Symbolisierungen lassen sich als Stil abspeichern, so dass du später auch anderen 
Layern schnell dasselbe Aussehen zuweisen kannst. Nutze dazu die Schaltfläche 
Stil > Speichere Stil... bzw. Lade Stil.... 

 

Abb. 28 
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in das Feld unter Ausdruck, markiere dann einen Platzhalter und doppelklicke auf das 

entsprechende Sentinel-2-Band unter Layer. Alternativ kannst du die Formel auch Klick 

für Klick über die Operatoren eingeben.  

 

Lege unter Reference layer(s) ... einen Bezugslayer fest, um Pixelgröße, Ausdehnung 

und KBS der Ausgabedatei festzulegen. Speichere bei Bedarf das Ausgaberaster über 
Output ... > In Datei speichern..., setze abschließend ein Häkchen bei Öffne 

Ausgabedatei nach erfolgreicher Ausführung und klicke auf Starte. 

 

Nach der Berechnung kannst du den Rasterkalkulator schließen, den neuen Layer in NDWI 

umbenennen und ihn farbig symbolisieren. Stelle unter Darstellungsart 
Einkanalpseudofarbe ein, wähle einen passenden Farbverlauf, z.B. von Hell- nach 

Dunkelblau (Blues), und spiele mit den Symbolisierungsoptionen, um die Unterschiede 

besser hervorzuheben (vgl. S.21, Symbolisieren eines Einkanalrasters am Beispiel NDVI).  

Achte auf eine korrekte Syntax und die Leerzeichen vor und nach den Operatoren. 

Abb. 29 
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Niedrige Werte (Bereiche mit geringem Blattwassergehalt wie z.B. auf abgeernteten 

Ackerflächen) sind nun hellblau dargestellt. Hohe NDWI-Werte, also Bereiche mit hohem 
Blattwassergehalt, z.B. in der Flussaue, sind dunkel eingefärbt.  

 

 

  

Abb. 30 
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Exkurs Vektordaten und offene Geodaten 

Vektordaten kann man selbst erstellen, z.B. aus Rasterdaten über das GRASS-Werkzeug 
r.to.vect oder durch das Abdigitalisieren einer Karte über die Editierfunktion im GIS. 

Man kann sie auch kaufen und sogar als offene Geodaten kostenlos herunterladen oder 
über einen Web Feature Service beziehen. Inzwischen gibt es im Internet eine Vielzahl frei 
verfügbarer Geodaten von hervorragender Qualität. Immer mehr Bundesländer stellen 
offene Daten der Landesämter für Vermessungswesen oder Geoinformation über 
Geodatenportale zur Verfügung; entweder als direkte Dateidownloads oder sogenannte 
Webdienste, die dann in eigene GIS-Systeme oder Anwendungen integriert werden 
können. In der folgenden Tabelle sind einige Beispiele aufgelistet.  

Bundesland Portal Urheber 

Baden-
Württemberg 

LGL 
https://www.lgl-bw.de/Produkte/Open-Data/  

LGL Landesamt für Geoinformation  
und Landentwicklung 

Bayern 
 

OpenData Portal der Bayerischen Staatsregierung 
https://www.ldbv.bayern.de/produkte/weitere/opendata.html 

Landesamt für Digitalisierung, 
Breitband und Vermessung 

Berlin 
 

FIS-Broker 
https://fbinter.stadt-berlin.de/fb/ 

Senatsverwaltung für Stadt-
entwicklung, Bauen und Wohnen 

Brandenburg 
 

GEOBROKER 
https://geobroker.geobasis-bb.de/ 

LGB Landesvermessung und 
Geobasisinformation Brandenburg 

Hessen 
 

Geodaten Online 
https://gds.hessen.de  

Hessische Verwaltung für Boden-
management und Geoinformation 

Mecklenburg-
Vorpommern 

Geoportal MV 
https://www.geoportal-mv.de/portal/  

Landesamt für innere Verwaltung MV, 
Amt für Geoinformation, Vermessungs- 
und Katasterwesen 

Niedersachsen 
 

OpenGeoData.NI 
https://opengeodata.lgln.niedersachsen.de/  

LGLN Landesamt für Geoinformation 
und Landesvermessung Niedersachsen 

Nordrhein-
Westfalen 

 

Geobasis NRW 
https://bezreg-koeln.nrw.de/ 
brk_internet/geobasis/opendata/index.html  

Bezirksregierung Köln 
 
 

Rheinland-Pfalz 
 
 

Open Data – Freie Daten und Dienste der Vermessungs- und 
Katasterverwaltung Rheinland-Pfalz 
https://lvermgeo.rlp.de/de/geodaten-geoshop/opendata/  

Landesamt für Vermessung und 
Geobasisinformation 
 

Sachsen 
 

Offene Geodaten 
https://www.geodaten.sachsen.de/  

Staatsbetrieb Geobasisinformation und 
Vermessung Sachsen GeoSN 

Sachsen-Anhalt 
 
 

Dienste & Download  
https://www.lvermgeo.sachsen-anhalt.de/de/ 
dienste__download.html 

Landesamt für Vermessung und 
Geoinformation Sachsen-Anhalt  
 

Thüringen 
 
 

Geoportal-TH 
https://www.geoportal-th.de/de-de/Downloadbereiche/Download-
Offene-Geodaten-Thüringen  

Landesamt für Bodenmanagement und 
Geoinformation 
 

   

Bundesweit 
 

Open Data des BKG 
https://gdz.bkg.bund.de/index.php/default/open-data.html  

Bundesamt für Kartographie und 
Geodäsie  

 

Eine sehr gute Übersicht bietet auch OpenGeoEdu auf der Seite 
https://learn.opengeoedu.de/opendata/vorlesung/offene-geodaten/amtliche-
geodaten und dem OpenDataPortal https://portal.opengeoedu.de/. 

https://www.lgl-bw.de/Produkte/Open-Data/
https://www.ldbv.bayern.de/produkte/weitere/opendata.html
https://fbinter.stadt-berlin.de/fb/
https://geobroker.geobasis-bb.de/
https://gds.hessen.de/
https://www.geoportal-mv.de/portal/
https://opengeodata.lgln.niedersachsen.de/
https://bezreg-koeln.nrw.de/%0bbrk_internet/geobasis/opendata/index.html
https://bezreg-koeln.nrw.de/%0bbrk_internet/geobasis/opendata/index.html
https://lvermgeo.rlp.de/de/geodaten-geoshop/opendata/
https://www.geodaten.sachsen.de/
https://www.lvermgeo.sachsen-anhalt.de/de/%0bdienste__download.html
https://www.lvermgeo.sachsen-anhalt.de/de/%0bdienste__download.html
https://www.geoportal-th.de/de-de/Downloadbereiche/Download-Offene-Geodaten-Thüringen
https://www.geoportal-th.de/de-de/Downloadbereiche/Download-Offene-Geodaten-Thüringen
https://gdz.bkg.bund.de/index.php/default/open-data.html
https://learn.opengeoedu.de/opendata/vorlesung/offene-geodaten/amtliche-geodaten
https://learn.opengeoedu.de/opendata/vorlesung/offene-geodaten/amtliche-geodaten
https://portal.opengeoedu.de/
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Einladen bereits vorhandener Vektordaten 

Die einfachste Variante ist das sogenannte Drag & Drop. Du kannst vom Speicherordner 

deiner Dateien aus die gewünschte(n) Vektordatei(en) einfach markieren, bei gehaltener 
linker Maustaste ins QGIS-Fenster ziehen und dort loslassen.  

 

Alternativ kannst du auch im QGIS-Menü über Layer > Layer hinzufügen > Vektorlayer 

hinzufügen deinen Layer einladen. Wähle Datei als Quelltyp. Klicke auf ... und navigiere 

zum Speicherort deiner Vektordatei.  

 

Zur besseren Auffindbarkeit wähle das gesuchte Dateiformat aus, dann deine Datei und 

bestätige die Auswahl mit Öffnen. Anschließend klickst du auf Hinzufügen und Schließen. 

 

Abb. 31 

Abb. 32 

Abb. 33 
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Gewinnen von Vektordaten aus einem Web Feature Service (WFS) 

Ein Web Feature Service ist ein Webdienst, der georeferenzierte Vektordaten bestehend 
aus so genannten „Features“ ausgibt und sich in ein GIS oder webbasierte 
Kartenanwendungen einbinden lässt.   

Für dieses Beispiel verwenden wir einen kostenfreien WFS des Geoportals MV. Um an die 
URL dieses Dienstes zu kommen, öffne die Webseite https://www.geoportal-
mv.de/portal/Geowebdienste/Fachthemen/Landwirtschaft_und_Forst und erweitere die 
Ansicht für Feldblockkataster MV WFS > einblenden. Die URL findest du am Ende des 

Abschnitts. Markiere die URL und kopiere sie mit STRG+C in den Zwischenspeicher.  

 

 

Jetzt sollen die Daten als WFS-Layer in QGIS hinzugefügt werden. Wähle dazu im QGIS-
Menü Layer > Layer hinzufügen > WFS-Layer hinzufügen und lege eine neue WFS-

Verbindung an. Klicke dazu auf Neu. Füge die kopierte Adresse des Webdienstes in das 

Feld URL und eine Bezeichnung für die neue Verbindung in das Feld Name ein. Bestätige 

mit OK.  

Auch andere Bundesländer bieten Feldblockkataster als WFS an. Hier ein Link zum 
Geobroker für Brandenburg.  

Abb. 34 

https://www.geoportal-mv.de/portal/Geowebdienste/Fachthemen/Landwirtschaft_und_Forst
https://www.geoportal-mv.de/portal/Geowebdienste/Fachthemen/Landwirtschaft_und_Forst
https://geobroker.geobasis-bb.de/gbss.php?MODE=GetProductInformation&PRODUCTID=9e95f21f-4ecf-4682-9a44-e5f7609f6fa0
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Klicke dann auf Verbinden. Die verfügbaren WFS-Layer erscheinen daraufhin in der Liste. 

Wähle Feldblockkataster MV - Feldblöcke aus und aktiviere das Häkchen Titel als 

Layernamen verwenden. Klicke zum Schluss auf Hinzufügen und Schließen.  

 

Der WFS-Layer erscheint nun in deinem QGIS-Hauptfenster. Um aus diesem Layer nur die 
relevanten Features für die Weiterverarbeitung herauszufiltern, markiere ein oder 
mehrere Feldblöcke und speichere sie in einem separaten Shapefile. Aktiviere dazu die 
Funktion Objekte über Rechteck oder Einzelklick wählen aus der Werkzeugleiste und 

klicke das gewünschte Feature an. Der entsprechende Layer muss dafür markiert sein. 

Mehrere Features gleichzeitig aktivierst du durch mehrmaliges Klicken bei gehaltener 
Shift-Taste. Speichere deine Auswahl mit Rechtsklick auf den Layer Feldblockkataster 

MV - Feldblöcke > Exportieren >  und wähle 

Abb. 35 

Abb. 36 
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Speicherformat und Speicherort über .... Achte darauf, dass das Häkchen gesetzt ist bei 

Gespeicherte Datei zur Karte hinzufügen und bestätige mit OK.  

 

 

Abdigitalisieren vom Raster- zum Vektorlayer 

Du kannst eigene Vektordaten in QGIS erstellen, indem du z.B. die Schlaggrenzen aus 

einem aktuellen Satellitenbild in einem leeren Vektorlayer nachzeichnest. Gehe dazu 
über das Menü zu Layer > Layer erstellen > Neuer Shape-Datei-Layer....  

 

  

Abb. 37 

Abb. 38 
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Weise dem neuen Layer über ... einen Dateinamen und Speicherort zu und lege als 

Geometrietyp Polygon fest. Falls du deinen aufgenommenen Daten weitere Attribute 

mitgeben möchtest, z.B. Schlagnummer oder Kulturart, definiere unter Neues Feld 

entsprechende Parameter und klicke auf Zur Feldliste hinzufügen. Klicke abschließend 

OK. 

 

Um im neu angelegten Layer eigene Features erstellen zu können, aktivierst du den 
Bearbeitungsmodus mit Klick auf das gelbe Stift-Symbol in der Werkzeugleiste und 

anschließend auf das Symbol Polygonobjekt hinzufügen. Mit dem Fadenkreuz-Mauszeiger 

kannst du nun Klick für Klick ein Polygon aufziehen und dich dabei an der Grundkarte 
orientieren. Du schließt das Polygon mit einem Klick mit der rechten Maustaste. Gib 
anschließend die Attribute an und bestätige mit OK. Solange der Bearbeitungsmodus 

aktiviert ist, kannst du weitere Polygone erstellen oder löschen. Um ein Objekt zu 
löschen, aktivierst du das Werkzeug Objekte über Rechteck oder Einzelklick wählen, 

markierst dann das Feature und drückst die Entf-Taste. Nachdem du die Features 

fertiggestellt hast, speichest du die Änderungen deines Vektorlayers mit Klick auf das 
rote Stift-Symbol > Speichern gewählter Layer und beendest den Bearbeitungsmodus 

durch erneuten Klick auf das gelbe Stift-Symbol.  

 

 

  

Attribute eines Vektorlayers kannst du in der Attributtabelle ändern, wenn sich der 
Layer im Bearbeitungsmodus befindet. Klicke mit der rechten Maustaste auf den 
Layer im Layer-Bedienfeld und wähle Attributtabelle öffnen. 

Abb. 39 
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Reprojizieren von Vektordaten 

Wie bereits erwähnt, ist es für genaue Prozessierungen wichtig, dass die beteiligten Layer 
dasselbe Koordinatenbezugssystem besitzen (siehe S.13, Anpassen des 
Koordinatenbezugssystems). Passe dazu das KBS des Vektorlayers an und benutze dazu 
das Werkzeug Layer reprojizieren. Du kannst die Suchleiste nutzen, um ein 

bestimmtes Werkzeug zu finden. Doppelklicke anschließend auf das entsprechende 
Werkzeug.  

 

Wähle als Eingabelayer deinen Vektorlayer aus, den du umprojizieren möchtest und als 

Ziel KBS das Koordinatenbezugssystem der Sentinel-2-Daten. Gib dann unter 

Reprojiziert den Ausgabepfad und Dateityp an, indem du auf ... > In Datei 

speichern... klickst. Halte deine Projektdateien übersichtlich und gib im Dateinamen die 

Projektion an. Klicke dann auf Starte und nachdem der Prozess abgeschlossen ist, auf 

Schließen.  

 

Abb. 40 

Abb. 41 
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Wie schneide ich mein Satellitenbild auf einen Ausschnitt zu? 

Nicht immer ist es notwendig, komplette Sentinel-2-Kacheln weiter zu verarbeiten, denn 
oft sind es nur kleinere Gebietsausschnitte, die von Interesse sind. Um 
Verarbeitungszeiten und Speicherlast gering zu halten, lohnt es sich, die 
entsprechenden Flächen aus den Daten zu extrahieren. Besonders praktisch ist es, einen 
Layer als Schablone zu benutzen und das Satellitenbild darauf zuzuschneiden. Hierzu 
eignen sich Vektordaten in Polygonform, die das gewünschte Gebiet genau definieren; 
aber auch Rasterdaten können als Schnittmaske benutzt werden. Beispielhaft soll hier 
das Raster per Polygon-Vektor auf einen landwirtschaftlichen Ackerschlag zugeschnitten 
werden.  

Zuschneiden auf ein Polygon 

Wähle im Menü Raster > Extraktion > Raster auf Layermaske zuschneiden.  

 

Abb. 42 
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Der Eingabelayer ist das Raster, z.B. der berechnete NDVI. Der Maskenlayer ist z.B. der 

vorher umprojizierte (Polygon-) Vektorlayer mit den Feldgrenzen. Gib unter Abgeschnitten 

(Maske) > ... > In Datei speichern... wieder einen Ausgabepfad, Dateinamen und 

Dateityp an, bestätige mit Starte und klicke auf Schließen, wenn der Prozess beendet ist.  

Die Satellitendaten sind nun auf den Ausschnitt der Polygonfläche zugeschnitten. 

 

  

Abb. 43 
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Wie exportiere ich die Daten als Bilddatei? 

Für bestimmte Zwecke kann es hilfreich sein, Daten nach Bearbeitung aus dem GIS zu 
exportieren, z.B. um sie für ein anderes Projekt oder eine Präsentation zu verwenden. 
Dafür stehen verschiedene Dateiformate zur Verfügung. Über das Format GeoTIFF können 
Daten verlustfrei und mit zusätzlicher Georeferenz heruntergeladen werden.  

Um einen bestimmten Layer als GeoTIFF abzuspeichern, wähle nach Rechtsklick auf den 
entsprechenden Layer die Option Exportieren > Speichern als. Setze den Ausgabemodus 

auf Wie dargestellt, wähle unter Format das gewünschte aus und gib unter Dateiname > 

... den gewünschten Speicherort und Dateinamen an. Setze ein Häkchen neben 

Gespeicherte Datei zur Karte hinzufügen, wenn du das Exportergebnis in QGIS 

überprüfen oder damit weiterarbeiten möchtest.  

 

Abb. 44 
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Wenn du nicht nur einen einzelnen Layer, sondern deine gesamte aktuelle 

Zusammenstellung als Bild exportieren möchtest, ggf. in geringerer Auflösung oder ohne 
Georeferenzierung, kannst du im Menü über Projekt > Import/Export > Karte als Bild 
speichern deine Arbeit auch als JPG, PNG, etc. ausgeben lassen. Auch eine PDF-Option 
findet sich dort.   

Es öffnet sich dann ein neues Fenster, in dem du den Kartenausschnitt sowie weitere 
Parameter festlegen kannst. Um die Kartenausdehnung zu definieren, musst du nicht 
unbedingt die genauen Koordinaten eingeben. Du kannst einfach den aktuellen 
Ausschnitt nehmen, den du gerade in deinem Kartenfester siehst. Klicke dazu auf die 
Schaltfläche Kartenausschnittsausdehnung. Alternativ kannst du aber auch über das 

Drop-Down-Menü Aus Layer berechnen die Ausdehnung eines anderen Layers 

übernehmen, der sich in deinem Projekt befindet.  

Ebenso kannst du deinen Export über Maßstab, Ausgabebreite und Ausgabehöhe 

definieren. Als Auflösung sind 300 dpi zu empfehlen. Ist der Export nur für die 
Bildschirmansicht und nicht für den Druck, reichen auch 72 bis 150 dpi.  

Über das Häkchen neben Georeferenzierungsinformation anhängen (eingebettet oder 

als World-Datei) kannst du steuern, ob dein Bild mit oder ohne Georeferenzierung 

abgespeichert werden soll. Hat es eine Georeferenzierung, kann es in jedem anderen GIS 
und GIS-Projekt wieder eingelesen und an die richtige Stelle projiziert werden. Klicke auf 
Speichern.  

  

 

 

Abb. 45 



Satellitendaten visualisieren und analysieren   
– Erste Schritte mit QGIS 

 
37  

Es öffnet sich der bekannte Speicherdialog, über welchen du Speicherort, Dateiname und 

Dateityp festlegen kannst. Klicke dann wieder auf Speichern.  

 

Nach dem Abspeichern sollte deine Bilddatei in dem von dir vorher festgelegten Ordner 

und Dateiformat vorliegen. Hast du das entsprechende Häkchen vorher gesetzt und als 
Dateiformat z.B. PNG ausgewählt, wird neben deiner PNG-Datei zusätzlich eine PGW-
Datei ausgegeben, die die Georeferenzierung enthält. Solltest du diese nicht mehr 
benötigen, kannst du sie einfach löschen, ohne dass dies negative Auswirkungen auf 
deine PNG-Datei hat. 
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Weiterführende Online-Quellen 

SAPIENS Modul 2: Satellitendaten visualisieren und analysieren – Basiswissen (Q)GIS 
Teil 1 https://youtu.be/3hJh8YFxZfo  
Teil 2 https://youtu.be/ziR2Ljirq9w  

FERN.Lern Webseite: 
https://fernlern.gfz-potsdam.de/lernen  

FERN.Lern Youtube-Kanal: 
https://www.youtube.com/FernerkundungLernen  

 

QGIS Webseite  
https://www.qgis.org/de/site/  

QGIS Dokumentation 
https://docs.qgis.org/3.16/de/docs/user_manual/   

QGIS Grundlagen – Eine sanfte Einführung 
https://docs.qgis.org/3.16/de/docs/gentle_gis_introduction/  

QGIS Trainingshandbuch 
https://docs.qgis.org/3.16/de/docs/training_manual/  

 

QGIS Anleitungen und Tipps 
https://www.qgistutorials.com/de/ 

QGIS lernen – Eine GIS Lernplattform 
https://www.gis-lernen.de/  

Webdienste in QGIS nutzen 
https://flf.julius-kuehn.de/webdienste/webdienste-nutzen.html  

 

YouTube Kanal „Marshal Mappers“ 
https://www.youtube.com/channel/UCKwC9hcJr-4mgsNUeJzMAvA/videos  

YouTube Kanal „Skandigraph“  
https://www.youtube.com/channel/UCnmpPEb19bBIcTJ1QXu1k7Q/videos  

YouTube Kanal „PyQGIS“ 
https://www.youtube.com/channel/UCOnU8rXypMvJQ-Z0pl6mC9Q/videos  
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